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1 What is Architect? 
Asset DB Architect is a software tool that has been developed to aid the process of print 

fleet redesign.  A Device Fate matrix allows the current state print fleet (which has been 

captured using Asset DB) to be divided into devices for disposal, redeployment and 

devices to be kept in situ. A Product Catalogue then allows you to decide which new 

devices will make up the redesigned fleet.  The fleet can be modified in a designer view 

that provides a graphical means of creating new assets and automatically transferring 

features and volume from existing assets to new ones.  Assets from the existing 

environment that have been marked for redeployment are automatically redistributed in 

the new fleet with minimal intervention from the user.  The distribution process will find an 

optimised solution that places each asset where it is needed most.  When the new fleet 

has been designed, an evaluation view is provided to inspect the design and understand 

the changes that will be required to the existing fleet.  You can also calculate the costs 

and environmental impact of your new solution and then generate reports summarising 

the changes in textual and graphical form. 

2 The Solution Design Process 
Asset DB Architect is much more than just a software tool – it embodies a solution design 

process that is captured in the workflow of the tool.  The design process can be broken 

down into a series of distinct steps that are illustrated in Error! Reference source not f

ound. and described in more detail in the following sections.   

 

 

Figure 1. The Solution design process 

 

The solution design process works best if there is an agreed print policy covering the 

following: 

 

▪ The overall user to device ratio 

▪ Access to colour and Legal/ A3 devices 

▪ What is the maximum distance between a user and a device 

▪ Any special needs of certain departments or workgroups 

▪ Re-use/dispose guidelines for existing assets 



 Architect User Manual 

 - 2 - Asset DB v4.8.1 

 

▪ If the design is to be generic or make and model specific 

 

With these guidelines in place, the task of entering data into Architect is far more 

straightforward.  

3 Getting Started 
The starting point for a solution design using Asset DB Architect is an Asset DB project 

representing an existing printing environment.  Before continuing, you should ensure you 

have read the Asset DB Auditor and Analyst Manuals and are familiar with their contents. 

 

3.1 Capturing and Understanding the Existing Environment 
 

The first stage of any solution design is the detailed capture and analysis of the existing 

print environment.  There are a number of categories under which data needs to be 

collected for later analysis and design work: 

 

Device Attributes 

For each asset in the project, it is important to have valid make and model data so that 

these assets can be identified in the Architect views. Paper handling capabilities etc. of 

the current fleet are required to know which print features are required in the future fleet. 

 

Location Data 

The physical location of the current fleet devices is essential to help decide upon the 

distribution of future fleet devices. 

 

Volumes 

The solution design process makes use of volume data in the existing print fleet.  It is 

therefore crucial to ensure all assets have valid monthly volume data entered for them in 

the Asset DB project.  This can be accomplished in a number of ways – see the Asset 

DB Analyst manual for more details. 

 

When the print environment has been captured, a thorough analysis of the data is 

necessary before a new design can be started. The analysis should pay particular 

attention to the distribution of devices and volume through the site, the distribution of 

colour and A3 capability in the fleet and the print capacity at each location versus the 

volume requirements at that location. 

 

Top Tip: ensure your project volumes are stable before creating your solution and do not 

recalculate volumes after your solution is in progress. Recalculating volumes after you 

have begun a solution can result in negative volumes and errors in your solution design. 
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3.2 Creating a Solution 
 

Each Asset DB project can be assigned multiple solutions to show multiple future fleet 

options without the need for multiple projects.  A new solution is created and associated 

with the currently open project by selecting File > New > Solution: 

 

 

Figure 2. Creation of a new solution 

 

After the new solution is created, five new tabs should be visible across the top of the 

screen as shown in Figure 3. 

 

 

Figure 3. The Solution tabs 

 

Each tab represents a phase in the solution design process described previously.  The 

role of each tab is summarised briefly below: 

 

▪ Current State:  This tab shows the current print environment – it is simply the 

Asset DB project. 

▪ Data Preparation:  This tab enables users to review meter readings from the 

current state and also to generate volumes for the current fleet. 

▪ Device Fate: This allows a decision to be made about the fate of each device in 

the fleet. 

▪ Product Catalogue:  This allows decisions to be made about the new devices to 

appear in the future fleet and their volume capabilities. 

▪ Product Costs: This tab allows for the entry of cost data for the devices to be 

deployed in the future state. 

Solution Tabs 
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▪ Solution Design:  This is the design view where the new virtual print 

environment will be designed.   

▪ Future State:  This tab shows the new print environment after it has had new and 

redeployed devices deployed to it.  It also provides a summary view of all the 

changes on each floor. 

 

The Current State tab and the Data Preparation tab will not be discussed further in this 

document – see the Asset DB Auditor and Analyst Manuals for further information.  

 

3.3 Synchronising a Solution 
 

To allow for better collaboration, it is possible to synchronise a solution to the Asset DB 

Cloud so that it can be shared with others. 

 

After you have created a new solution for a project which has been synchronised with the 

Cloud, simply select Solution > Synchronise (see Figure 4) or File > Synchronise > 

Solutions… and the solution will be synchronised with the Asset DB Cloud. It is possible 

to create and synchronise several solutions for a project. 

 

 

Figure 4. Synchronising a solution with the Asset DB Cloud 

 

Once a solution is synchronised with the Asset DB Cloud, other users that have the same 

current state project open and up-to-date with the latest changes will be able to download 

any available solutions from the Asset DB Cloud by going to File > Synchronise > 

Solutions and then selecting a solution from the list (Figure 5). 
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Figure 5. Download solution from Asset DB Cloud 

 

In addition, there is the option to update your client with changes from the server without 

uploading any of your changes to the server. This is done via the Solution > Update 

Client… menu option.  

This allows you to receive all changes that other collaborators have made even if your 

changes are not yet ready to be shared. 

The functionality to write and view solution synchronisation messages is the same as in 

synchronising the current state, you can find more information in Section 22 of the 

Auditor manual. 

 

3.4 Locking and Unlocking features of a Solution 
 

When you have a solution open that has already been synchronised, you will need to 

lock the element you are working on before you are able to make any changes. The 

element could be the Product Catalogue or a site, building or floor. This is to ensure data 

integrity is maintained within the Solution.  

 

 

Figure 6. Locking a location 
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To lock a location in the project tree, simply select the site, building or floor you want to 

lock and click on the yellow lock (Figure 6). A key will then be displayed right next to the 

project tree item to indicate that you have that element locked.  

 

Once a lock is set on a location, only the lock owner is able to perform the following 

tasks: 

• Change fate of current state devices. 

• Drag volume, or otherwise change volume in the Solution Design. 

• Relocate a virtual asset onto another floor. Only the source floor needs to be 

locked. 

Other users are still able to access that element in order to perform the following tasks, 

necessary to be able to complete other parts of the solution and reporting: 

• Create a new Virtual Asset 

• Assign a device from the product catalogue to a virtual asset 

• Assign a redeployed device to a virtual asset 

• Run Solution Generator 

• Run reports 

Once the user who set the lock finishes work on the solution and synchronises it, the lock 

is removed. Nevertheless, it is possible to override another user’s lock on an element by 

clicking the lock yourself while they are offline, at which point the message in Figure 7 will 

be displayed. It is not advised to do this, as by overriding the lock, their changes will be 

discarded.  

 

 

Figure 7. Override Lock dialogue box 

 

When working on the Product Catalogue and in the Product Costs tab the padlock is 

located above these tabs (Figure 8). Applying a lock to the Product Catalogue will lock 

the Product Costs tab as well and vice versa. 
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Figure 8. Product Catalogue lock 

 

A lock applied on the Product Catalogue and Product Costs elements will prevent any 

other users from being able to perform the following tasks: 

• Adding new Models to the catalogue 

• Adding redeployed models to the product catalogue 

• Updating Costs of models in the product catalogue 

 

3.5 Assigning Sites, Buildings and Floors 
 

As explained in the Asset DB Auditor manual (section 4.4) it is also possible to assign 

project tree elements at the Solution stage. These assignments are separate from the 

assignments in the Current State tab, so a floor assigned to a person in the current state 

can be assigned to someone different in the future state. 

To assign a project tree element to a person, make sure the project as well as solution 

are synchronised with the Asset DB Cloud. Then follow instructions from section 4.4 in 

the Auditor manual. Anyone who has the same project and solution open, and is 

connected to the Asset DB Cloud will then see these changes in real time. 

 

3.6 Marking project tree elements as complete or incomplete 
 

To mark project tree elements as complete or incomplete, please see section 3.3 in the 

Auditor manual. Marking a project element as complete in the Solution is independent 

from marking it as complete in the Current State. 
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4 The Device Fate Tab 

 

Figure 9. The Device Fate view 

 

The Device Fate view lists all the in-scope assets in the project in tabular form. Any 

assets marked Out of Scope in the current state will not show in the Device Fate.  

 

Use the navigation tree at the top right hand corner of the screen to view the assets by 

site/building/floor. The tabular view shows various attributes for each asset that are 

considered useful in determining the fate of the asset. Further attributes can be added to 

this view by right clicking in the column header bar and selecting More… as shown in 

Figure 10. 

 

 

Figure 10. Adding new columns to the Device Fate table 

 

This will bring up a Column Selection window where you can decide which categories 

you would like to show/hide. 
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The purpose of the Device Fate view is to decide the fate of each asset in the project.  

Assets can be assigned one of three fates: 

 

▪ Dispose  – the asset is not required in the new fleet. 

 

▪ Redeploy  – the asset is to be utilised in the new fleet if possible. 

 

▪ In Situ  – the asset will remain in the fleet in its current location with its 

current volume or less. 

 

There are multiple factors that will help determine the fate of each device such as age, 

cost etc. all of which should be decided in the print policy. 

 

The fate of an asset can be selected in one of three ways; by highlighting the asset row 

and using one of the fate buttons in the toolbar, by right clicking on the table row for the 

asset and selecting a fate from the popup menu or by using the dropdown in the Fate 

column (see Figure 11). Initially the fate of each asset is set to ‘UNDETERMINED’ 

(shown in the ‘Fate’ column).  

 

 

Figure 11. Modifying the fate of devices 

 

A fate can be assigned to multiple assets by highlighting a number of rows and selecting 

their fate using either method described previously.  Multiple rows can be highlighted by 

using the left mouse button and dragging the mouse or selecting the top row of the group 

Fate 

buttons 

Select a 

fate from 

the drop 

down 
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and holding Shift while clicking the bottom. To highlight rows that are not adjacent press 

the CTRL key on the keyboard. 

 

Sometimes it is necessary to view an asset on the floor plan before a decision can be 

made about its fate.  This can be achieved by right-clicking the asset row and selecting 

‘View On Floor Plan’ as shown in Figure 12. 

 

 

Figure 12. Viewing devices on the floor plan 

 

This will take you to the Solution Design tab and highlight the asset on the floor. Note that 

the fate of a device can also be changed in the Solution Design view (see Section 7.9). 

 

Data can be sorted in the table by clicking on any column heading; clicking on the 

heading again will reverse the sort order.  You can also apply filters to the table by 

clicking on the down arrow next to each column header as shown in Figure 13. This is a 

very useful feature for grouping assets by any one of the displayed attributes and 

assigning them a fate in one step.   
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Figure 13. Applying filters 

 

Column widths can be changed by clicking on the divider between the headers of any 

two columns and dragging the mouse. 

5 The Product Catalogue Tab 
 

 

Figure 14. The Product Catalogue view 

 

The Product Catalogue view is composed of three separate areas; in the top right hand 

panel there is a table containing the distinct assets that are to be redeployed. Beneath 

this panel is an empty panel that will hold information about the assets that will make up 

the future state as they are assigned amongst the columns in the main panel to the left. 

For more details please go to section 5.2. 

 

Product Catalogue  

New models in a 

selected volume 

band 

Assets to redeploy  
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The main panel contains the Product Catalogue that will be customised for the given 

requirements and consists of a series of columns that each represents a particular 

category of device. The category represented by each column is shown in the column 

header.   

 

5.1 Altering Categories in the Product Catalogue 
 

The Product Catalogue has ten predefined device categories: 

 

▪ MFD A4 Black and White 

▪ MFD A4 Colour 

▪ MFD A3 Black and White 

▪ MFD A3 Colour 

▪ Printer A4 Black and White 

▪ Printer A4 Colour 

▪ Printer A3 Black and White 

▪ Printer A3 Colour 

▪ Fax 

▪ Scanner 

 

These may not all be present in the catalogue initially as only the required categories 

(derived from the existing print fleet population) are displayed.  Categories can be added 

or removed by selecting the Add/Remove button. 

 

Figure 15. Add/Remove device categories 

 

Within each category column in the main panel of the Product Catalogue there are a 

series of volume ‘bands’ that have a description and a numerical range.  These represent 

a categorisation of the overall volume range for the type of device described by the 

column.  The range for each band can be adjusted by clicking on the boundary between 

any two bands and dragging it up or down.   

 

Add/Remove Columns 

button 
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Figure 16. User defined volume bands. 

 

Each column therefore represents a volume profile for a given category of device. The 

first step in setting up your Product Catalogue is to decide the volume capabilities of a 

low, medium, high and very high volume device in each of your categories. 

 

For example, the Product Catalogue in Error! Reference source not found. shows that f

or Mono A3 MFDs any device that can do 0 to 7,999 pages per month is considered a 

Low volume device.  Any device that can do 8,000 to 19,999 is considered a Medium 

volume device, etc. 

 

5.2 Adding Redeployed Devices to the Product Catalogue 
 

Once the volume bands have been set for all categories of device, the next step is to add 

devices into these bands to make up the catalogue. 

The Product Catalogue will be made up of two groups of devices. The first group consists 

of brand new devices and the second consists of models that were redeployed in the 

Device Fate view. 

 

The assets marked for redeployment are all contained in the table shown in the top right 

panel shown with their serial number (see Figure 14).  Initially all rows in the table are 

highlighted in pink to indicate they have not yet been assigned to the Product Catalogue.  

A redeployed device is added to the product catalogue by first selecting the device, 

turning it red, and then click and dragging it across to one of the volume bands in the 

Product Catalogue on the left.  When the drag operation is started, the column into which 

the model should be dropped is highlighted with a red border as shown in Figure 17. 

 

Moveable 

boundaries 
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Figure 17. Automatic highlighting of the correct device category and volume band 

 

Select one of the volume bands in the highlighted column and release the mouse button 

to assign the model to that band.  If the model has been successfully dropped into the 

volume band the text describing the band will change to bold and underlined.  If you 

select the volume band and look at the bottom right hand panel, you will see the model 

listed under ‘Redeployed Models’ along with its capabilities. This area is described in 

more detail in Section 5.3. 

 

You should also notice that the model name in the top right table is no longer highlighted 

in pink as shown in Figure 18. 

 

 

Figure 18. Visual indicators for Redeployed device allocation in the Product Catalogue 

 

This process should then be repeated for all the models highlighted in pink in the top right 

table.  Models can be dropped into more than one volume band if required. 

Red highlight removed 

Bold, underlined text to 

indicate devices 

assigned 

Device in 

list 
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Multiple redeployed devices can be added to a single volume band by using the Control 

key to multiple select and dragging as above. 

 

Note that if you remove a redeployed device model from a volume band and the model 

has not been allocated anywhere else in the Product Catalogue it will be highlighted in 

pink again in the top right hand table. 

 

5.3 Locating a Redeployed Device in the Catalogue 
 

The location of a redeployed device in your catalogue can be displayed simply by clicking 

on the device in question in the top right panel. This will then highlight in yellow the 

volume band(s) in which it has been placed as shown in Figure 19.  

 

 

 

Figure 19. Visual indicators for Redeployed device allocation in the Model Matrix 

 

5.4 Adding and editing New Models within the Product Catalogue 
 

In addition to redeployed device models, it is also possible to add any model to the 

Product Catalogue.  The Product Catalogue provides an opportunity at this stage to 

decide which models will be considered for use in the new print fleet and where they sit in 

the Product Catalogue.   

 

To assign a model to any volume band click the volume band to highlight it and then 

select the ‘Add Device’ button in the bottom right panel as shown in Figure 20. 

 

 

Figure 20. Add/Remove new models to the catalogue 

 

Add Remove 

Selected device 

highlighted in purple 

Location of 

redeployed device 

highlighted in 

yellow 
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First, select a manufacturer and model in the New Model pop-up. This is done by either 

using the drop down lists or typing key characters into the field and selecting from the 

options given. You should now select each of the capabilities that apply to that model 

using the tickboxes as shown in Figure 21 before clicking on ‘Allocate New Model”’. 

 

Figure 21. Add/Remove new models to the catalogue 

 

The text in the category should now have changed to bold and the bottom right panel 

should now list the model you have added under ‘New Devices’. You can add multiple 

models to each volume band to cover as many capability options as you require. It is also 

possible to add multiple instances of the same device if required to allow for different 

capability options of the same model as shown in Figure 22. These distinct models will 

then appear as unique items in the Product Costs tab, which is further explained in 

Section 6. 

 

……………..  

Figure 22.  Multiple new models added to the catalogue 

 

New models and Re-deployed devices can be removed from any volume band by 

selecting them and clicking on the remove button (see Figure 20). 

Existing models can be edited by right-clicking and selecting “Edit Model” Figure 22). 
When the same asset is included in different volumes ranges or categories it is possible 
to edit the capabilities of an individual model without needing to create a new one. Once 
the model has been edited and the Solution Generator has been run then the model 
information will automatically update on the floor plan. Please note that once the 
information has been changed then the pricing will be reset to 0 in the Product Costs tab. 

 

Multiple Models in a 

Volume Band with different 

Capability Options Edit Models in a 

specific Volume Band 
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Figure 23. Edit models in the Product Catalogue 

 

Once a new feature has been added, the “Update Model” button becomes available. 

 

If there is an existing project and solution on the Enterprise Server then the product 

catalogue needs to be locked for the model to be edited. For further details on how to 

lock and unlock features of a solution, please refer to section 3.4. 

 

If new models are not added to the Product Catalogue at this stage, Architect will use 

generic descriptions for new devices until they have been added. This method will not 

allow a financial or environmental comparison to be run however.  

 

5.5 Creating a New Catalogue 
 

A new, empty Product Catalogue can be created by clicking the ‘create a new default 

catalogue’ button as shown in Figure 24.  Note that this will remove the existing matrix 

and create a new blank one that does not contain any models.  This blank catalogue will 

again be modelled on the current fleet population. 

 

Figure 24. Create a new Product Catalogue 

5.6. Undoing and reverting changes in the Product Catalogue 
Any changes that have been made to the Product Catalogue can be undone when 

selecting the “Undo” button.  

Create new Product 

Catalogue 
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Figure 25. Undoing changes in the Product Catalogue 

 

The redo button becomes available when a change in the Product Catalogue has been 

applied and one of these changes has been undone: 

 

Figure 26. Redoing changes in the Product Catalogue 

 

Please note that once a change in the Solution has been synchronised all changes are 

permanent and they cannot be undone. 

 

5.6 Importing/Exporting Product Catalogues 
 

Product Catalogues can be exported from Asset DB and then imported into other 

solutions.  This means you can create and export a default Product Catalogue and then 

import and customise it for each solution. The exported catalogue will also include all 

costs entered within the Product Costs tab (as described in Section 6). To export a 

catalogue use the Solution>Export>Product Catalogue menu option (as shown in Figure 

27). 

 

 

Figure 27. Export/Import Product Catalogue 
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To import a Product Catalogue use the Solution>Import>Product Catalogue menu option 

and then locate the desired .atp catalogue file. When a catalogue is imported, all the 

models that have been placed in it are also imported with it.  Note that the imported 

catalogue will overwrite the existing one. This means that any re-deployed devices that 

were assigned to volume bands before the catalogue was imported will need to be re-

assigned to their respective volume bands.  

6 The Product Costs Tab 
The Product Costs tab allows for the allocation of cost data to the future fleet models that 

will subsequently be used to determine the costs associated with the new print 

environment. 

It displays the data information, any lease costs that have been added, as well as if the 

model is an existing model in the print fleet or if it has been added via the product 

catalogue. A checkmark in the status bar indicates that the model is present in the 

product catalogue, while an exclamation mark highlights any models that have the status 

of being redeployed but they have not been allocated to a volume band yet. 

 

 

Figure 28. The Product Costs view 

 

6.1 Entering Cost Data 
 

The Product Costs tab lists all distinct new models that have been added to the Product 

Catalogue along with their capabilities. As mentioned previously, if multiple instances of 

the same model have been added to the product catalogue then they will each appear as 

a separate line item, differentiated by their unique capabilities. It also displays each 

individual redeployed and In-Situ device from the existing fleet along with its serial 

number.  

 

Devices that have been allocated to a 

volume band 

Devices still to be 

allocated to a volume 

band 
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Data can be entered for one or more rows by selecting them and then using either the 

right click menu option or the Edit button on the toolbar or to edit a single value clicking 

on it will allow the value to be edited. See Figure 29. 

 

 

 

Figure 29. Editing cost data 

 

Each editable data item is explained as follows: 

 

▪ Lease Cost: The lease cost of the device 

▪ Lease Cost time period: The time period for the lease cost payments 

▪ Recurring Cost: Any other recurring costs (maintenance etc.) 

▪ Recurring cost time period:  The time period for the recurring costs 

▪ CPP Mono: The cost of printing a mono page 

▪ CPP Colour: The cost of printing a colour page 

▪ CPP Colour Level 1: The cost of printing a Colour Level 1 page 

▪ CPP Colour Level 2: The cost of printing a Colour Level 2 page 

▪ CPP Colour Level 3: The cost of printing a Colour Level 3 page 

 

6.2 Importing/Exporting Product Cost Data 
 

Should you wish to construct a new product catalogue or import a product catalogue that 

does not contain any product costs: these can be exported, edited and imported 

independently of the product catalogue. To achieve this, select menu option Solution > 

Product Costs > Export. This will create a .csv file, into which can be added leasing 

costs, cost per click costs and any other recurring costs as well as the billing intervals 

(monthly, quarterly or annual). Once these data have been entered into the .csv file, they 

can be imported back into the Product Costs tab via menu option Solution > Product 

Costs > Import. Any costs that were already present in your product catalogue will be 

present in the .csv file and are editable in this way.  

 

Right click 

menu 

Select a 

single value to 

edit 

Edit 

button 
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Figure 30. Importing/ Exporting Product Costs 

  

Export Product Cost 

Import Product Cost 
dataset 
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7 The Solution Design Tab 
The Solution Design view is the design studio for creating a new virtual print 

environment.  Initially, this view shows the existing print fleet and augments each icon 

with volume information.  

 

 

Figure 31. The Solution Design view 

 

The print volume for a device is shown below it, mono volume in black and colour volume 

(if any) in red. Scan volume is shown above it in purple. Each icon will also be annotated 

with an icon that represents the fate of the device as determined earlier in the Device 

Fate tab. 

 

Some devices may be shown as hollow circles or squares on the floor plan.  Those 

devices have no volume data associated with them – before continuing you should check 

why they have zero volume.  There will also be a bin icon on the floor, initially located in 

the top left corner.  This is the volume bin and it is described in Section 7.7.   

 

Finally, the table view will also be present at the bottom of the screen showing details of 

all the current devices. In addition to fields seen in the Current State view, the table view 

will also include extra fields that will aid you in the Solution Design process: 

 

▪ Physical/Virtual: This will show whether a device is physical, i.e. a current state 

device or virtual, i.e. a future state device (described further in Section 7.1). 

▪ Status: This column will show either OK or Error. If it shows as Error, there will 

be a problem preventing a complete solution that needs to be rectified. This is 

explained further in Section 7.13. 

▪ Fate: For all devices that are included in the solution, this will show a symbol 

signifying the fate of each device (as chosen in the Device Fate tab). 

▪ Included in Solution: This signifies if an asset is to be included in the solution 

design process or not. Assets that would be included are all in scope Printers, 

The Volume 

Bin 

Redeployed 

Asset 

Disposed asset 

Redeployed Asset 

with zero volume 

In-Situ Asset 
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MFPs, Scanners and faxes. Out of scope devices and non-print devices such as 

PCs and filing cabinets would not be included. 

 

Note that the existing print fleet devices cannot be moved or otherwise modified in the 

Solution Design view. 

 

7.1 Adding Virtual Devices to the Floor 
 

The bottom left panel contains an ‘Icons’ tab that can be used to place new virtual 

devices onto the floor to create your future state fleet.  A device is placed on the floor just 

as it is in the Current State tab (see Asset DB Manual).  When a device has been placed 

onto the floor, it will be marked with a gold star that indicates it is a virtual device.  It will 

also appear in the table with Virtual in the Physical/Virtual column. The virtual device will 

not have any attributes at this point – these will be determined by dragging them across 

from surrounding devices from the existing print fleet. 

 

7.2 Volume Transfer 
 

Once you have placed a virtual device, if you click on any existing device and start 

dragging the mouse away from it the cursor will change to show a stack of papers to 

indicate print volume being dragged from the device.  You can transfer the print volume 

to a virtual device by releasing the mouse button over the virtual device.  A dialog will 

appear that contains options for transferring volume and capabilities. Capabilities can be 

transferred/added to the virtual device by ticking/unticking the relevant tick boxes. 

Customised fields that contain information to be carried over to a solution will appear 

under “Other Values”. 

   

To transfer the volume, you can select one of the predefined percentages to transfer, or 

use the slider or volume field to manually enter the exact amount to transfer. The 

percentage of volume you are transferring will show beneath the volume (Figure 32).  
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Figure 32. Volume transfer dialogue 

 

Should you wish to transfer volumes into a virtual tri-colour meter device, you need to go 

to Medium or High volume level tabs by clicking the relevant button at the top of the 

Volume section of the window. Within those tabs, the volumes are divided into three 

categories and you will need to decide the volume percentage you wish to transfer from 

each category. Once the transfer is complete, Asset DB will allocate the volumes to the 

corresponding category. 

 

If you are transferring volumes from a tri-colour meter device to a single colour meter 

virtual device, you should choose the Low volume button and it will consider mono and 

colour volumes as a whole.  

 

Figure 33 shows the volume transfer window for each level of detail. 
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Figure 33. Volume transfer details 

 

Once the volume has been transferred from an existing device to a virtual device, the 

volume path is represented by an orange arrow as shown in Figure 34. The Volume 

Transfer links can be turned on or off in the filters tab (described in Section 7.18). 

 

 

Figure 34. Volume transfer link 

 

If all the volume is transferred from a device, it will be represented as a hollow circle or 

square (see Figure 34). This feature allows the user to see at a glance which existing 

devices are yet to be addressed.   

 

Dragging volumes and attributes from the existing print devices to new virtual devices is 

central to the entire Architect design process.  The new virtual print environment is 

created by adding virtual devices to the floor and then dragging volumes and attributes 

from the existing print fleet to the virtual devices.  By encouraging the user to design the 

virtual environment in this manner, Architect can guarantee that, at a minimum, the print 

volumes and attributes of the existing fleet are preserved. 

 

7.3  Changing a Virtual Asset Icon Type 
 

At any point during the Solution Design phase, it is possible to change the icon type of a 

virtual asset (i.e. from an MFD to a printer). This is done in the same manner as in the 

current state in that you should right click the device and then select Change Icon. This 
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will then show a pop-up where you can select any other solution icon to replace the 

current icon. 

 

7.4 Transferring Volume from Virtual Devices 
 

Sometimes it is necessary to transfer volumes and attributes from virtual devices either to 

other virtual devices or back to existing fleet devices.  To initiate a transfer from a virtual 

device hold down the SHIFT key and drag the mouse from the device.  If the mouse is 

dragged without holding the SHIFT key down, the asset will be moved instead of volume 

being transferred.  If the volume is being transferred back to an existing device, the 

maximum value that can be transferred is equal to the amount that was transferred from 

the existing device to the virtual device originally.  

 

 

 

7.5 Transferring Volume from Multiple Devices 
 

Volume can be transferred from multiple devices in one of two ways. 

 

Hold down the CTRL key and click on each existing device with the mouse.  When all 

devices have been selected the transfer can be initiated by dragging the mouse from any 

one of the selected devices to a virtual device. 

 

Use the Multiple Select button to select the existing devices and then initiating the 

volume transfer by dragging the mouse from any one of the selected devices. 

 

 

Figure 35. Transferring volume from multiple assets 

 

In the case that virtual devices are also selected with this option, the transfer would not 

be possible. To rectify this, the virtual device has to be deselected by holding CRTL and 

clicking on the virtual device. 

 

7.6 Undoing Volume Transfers 
 

It is possible to undo a volume transfer by manually dragging volumes back to their 

device of origin.  The volume transfer link will help to see to where the volume needs to 

go back. However, Architect provides two much neater mechanisms to achieve this.  The 

first of these is an Undo button. 

Multiple select 

devices  
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Figure 36. The undo button 

 

After volumes have been transferred, they can be undone by clicking this button.  Each 

volume transfer is undone separately, so the button may need to be used multiple times 

to revert back to the starting state. Note that the undo and redo buttons are not specific to 

volume transfers and can be used to undo/redo many of the Architect operations.  To 

check which operations are next in line for undo/redo you can hover above the buttons 

with the mouse and a tooltip describing the operation will appear after a short pause. 

 

A second more powerful function for undoing all volume transfers is the ‘Reset Volume 

Transfers’ button: 

 

 

 

 

Figure 37. The reset volume button 

 

This button will reset all volume transfers for the whole project.  Pressing the undo button 

after using this feature will undo the reset operation and return the project back to the 

state it was in before the volume reset.  

 

7.7 The Volume Bin 
 

The volume bin is provided for three reasons: firstly, it captures volume when a virtual 

asset to which volume had been previously transferred is deleted. Secondly, it can be 

used as a store for temporarily holding volumes before they are transferred to their 

ultimate destinations and thirdly, it can be used to reduce the amount of volume on a 

floor in line with new print rules.   

 

When a virtual asset is deleted, any volume assigned to it is automatically transferred to 

the volume bin.  This is necessary to preserve the total volume in the environment.  If this 

transfer to the bin did not take place, the volume on the deleted asset would be lost in the 

new virtual environment.   

 

Volume is dragged to the bin for storage or volume reduction purposes just as if it were a 

virtual asset. Volume can be dragged from the volume bin in the same manner as for 

virtual devices (by holding down the SHIFT key). 
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volume 
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7.8 Invalid Volume Transfers 
 

Not all volume transfers are valid in Architect.  It is not possible to transfer volume: 

▪ Between existing devices, including onto an In Situ device; or 

▪ From a virtual device to an existing device, that was not the source of the volume 

on the virtual device. It is only possible to “return” volume to the source, rather 

than transferring it to a different existing device.   

 

7.9 Changing the Fate of an Existing Asset 
 

As mentioned earlier. It is possible to change the fate of an existing asset within the 

Solution Design tab. 

 

To set the fate, right click on an existing device and select the desired option from the 

Fate menu.  

 

Alternatively, you can use the device fate buttons in the Asset DB toolbar (Figure 11).  

 

 

Figure 38. Change the fate of an existing asset in Solution Design view 

 

7.10 Volume Transfer Statistics 
 

The state of volume transfer from the existing print fleet to the new virtual fleet is 

displayed within the Volumes tab in the bottom right panel.  
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Figure 39. Volume Transfer Statistics 

 

The statistics shown relate to the object (site/building/floor) selected in the navigation tree 

in the top right panel or the department selected on the floor.   

 

▪ Existing assets with zero volume originally: The number of devices in the 

existing fleet with no volume data.  These should be reviewed, as there may have 

been an error in volume generation. 

▪ Existing assets with all volume transferred: The number of devices in the 

existing fleet that have had all their volume transferred into the new virtual 

environment. All virtual assets should have volume assigned to them. 

▪ Virtual assets with assigned volume: The number of virtual devices that have 

had some volume transferred to them. 

▪ Mono volume: The amount of Mono volume that has been transferred into the 

virtual environment from the existing fleet. 

▪ Colour volume: The amount of Colour volume that has been transferred into the 

virtual environment from the existing fleet. 

▪ Scan volume: The amount of Scan volume that has been transferred into the 

virtual environment from the existing fleet. 

 

Each statistic is updated automatically. 

 

Once all figures are shown in green with corresponding ticks, you are ready to generate 

your solution. 
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7.11  Generating the Solution 
 

The new print environment that has been created thus far is a virtual environment.  If you 

select any of the devices and look at their attributes in the top left panel, you will see that 

they are described in generic terms. 

 

Architect contains an automated function for transforming the virtual environment into a 

real one that can be accessed via the ‘Run Solution Generator’ button in the toolbar as 

shown in Figure 40. 

 

This Solution Generator function looks at the volumes and attributes of each virtual 

device in the future fleet and matches them with a model in the product catalogue. 

 

 

Figure 40. The solution generator button  

 

When the Solution Generator is executed, Architect initially tries to place as many of the 

redeployed devices from the existing fleet as it can into the virtual environment.  A 

redeployed device will only map to a virtual device if it is appropriately placed into the 

Product Catalogue and matches the requirements of that virtual device.  If there is more 

than one device that matches, Architect will select the device that is located closest to the 

virtual device. The mapping process therefore intelligently matches redeployed devices 

to virtual devices based on similar capabilities while at the same time minimising physical 

movement of the redeployed fleet. 

 

Once Asset DB has mapped all of the redeployed devices, there may still be virtual 

devices that have not had a device mapped to them. Architect will then assign a model to 

each such device by looking in the Product Catalogue for a suitable new model to use.  

Again, the suitability is determined by matching print volumes and capabilities.  This is 

where the importance of selecting the capabilities of each device in the Product 

Catalogue comes into play. 

 

Once volume generation is complete, if you select any of the devices and again look at 

their attributes in the top left panel you will see that they now contain specific make and 

model details. These details will also be shown in the table view. 

 

7.12  Redeployed Device Movement 
 

When allocating redeployed devices, Asset DB will by default look throughout your entire 

project for a suitable location. 

Solution 

generator 
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This movement can be limited however to a Site, Building or Floor level. That is, a 

Redeployed device can only be deployed within the Site, Building or Floor in which it 

currently exists. This is done by selecting Solution>Redeployed Device Movement and 

then selecting the level of restriction you wish to enforce as shown in Figure 41. 

 

 

Figure 41. Restricting Redeployed device movement 

 

 

7.13  Solution Generation Errors 
 

It is possible that not all the redeployed devices from the existing print fleet can be 

utilised in the new virtual environment.  Likewise, there could be virtual devices to which 

no suitable model can be assigned. If this is the case, Architect will indicate this in the 

dialogue that appears when the ‘Run Solution Generator’ button is pressed as shown in 

Figure 42. If this is the case then the solution will have to be amended to create a 

complete solution. 
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Figure 42. The Solution Generator pop-up 

 

Further information detailing the specific devices with such errors can be shown by 

clicking on the Show Details button. 

 

These solution generator errors are also displayed in the table view. The status column 

will show either “OK” for assets where there are no errors or “Error” for those that need 

amending before a complete solution can be generated. 

 

If you hover over a row in the table that is showing as “Error” then this will show a tooltip 

with further details of that error. It will also highlight the device on the floor with an 

additional tooltip as shown in Figure 43. This also will allow you to identify the devices 

that need amending to enable you to create a complete solution. 
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Figure 43. Table view error tooltips 

 

7.14  Asset Status Labels 
 

It is also possible to determine the status of redeployed devices in the existing fleet and 

the status of virtual devices in the new environment from the Asset Status labels.  

 

Once the solution generator has been run, each device icon in the Solution Design tab 

will automatically display with a red cross or a green tick next to it to indicate its status as 

shown in Figure 44.  

 

Figure 44. Device status during solution design 
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The meaning of each symbol varies depending on the asset type. 

 

For existing redeployed assets: 

▪ Red Cross: Device cannot be mapped to a virtual device 

▪ Green Tick: The redeployed asset can be mapped to a virtual device. 

 

For existing disposed assets: 

▪ Red Cross: The asset still has volume that has not been transferred to a virtual 

device. 

▪ Green Tick: All volume has been transferred to virtual device(s). 

 

All In Situ devices will show a green tick as they cannot encounter the errors that would 

cause the red cross. 

 

For virtual assets: 

▪ Red Cross: No existing asset or new model can be assigned to it.   

▪ Green Tick: An existing asset or new model can be assigned to it.   

 

The presence of red crosses does not necessarily mean something is wrong as in some 

cases it may be a perfectly reasonable approach to create a solution in which virtual 

devices remain abstract and are described in generic terms.  Likewise, it is also 

reasonable that some redeployed assets cannot be deployed in the new environment 

and will be kept in storage for spares/replacements. 

 

To turn these labels on and off, simply select the Filter tab in the bottom left of the 

console, then tick/untick the Asset Status labels field. 
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Figure 45. Filter tab in tabbed tool console 

 

7.15  Overriding Architect Decisions 
 

There are sometimes external constraints that cannot be taken into account by an 

automated function like the Solution Generator and require manual intervention from the 

user.  Under these circumstances, it is possible to override the Solution Generator 

function and do some things manually. 

 

7.16  Manually Assigning Make and Model to a Virtual Device 
 

It is possible to gain control of a virtual asset by right clicking on it and selecting the 

‘Manual Changes Only’ option. 

 

 

Asset status 

label tick box 
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Figure 46. Gaining control of virtual assets 

 

The gold star on the asset will change to white to indicate the asset will not be modified 

by the Solution Generator function.  Now that the asset has been put under the control of 

the user, it is possible to alter its make and model by selecting a new device from the 

product catalogue. 

 

This is done by right clicking the device again and this time selecting Manually Assign 

(shown in Figure 46). This will then bring up a pop-up showing all of the devices in your 

product catalogue. A device is then chosen by scrolling to find the correct model type, 

then expanding the relevant volume band and selecting the desired model as shown in 

Figure 47. If the device intended for use does not appear in the Product Catalogue for 

selection, go back to the Product Catalogue tab and add the device there. Cost 

information will also need to be added to the Product Costs for this newly added device. 

Any device in the Asset DB device database may be manually assigned to the virtual 

device, the above procedure will still be needed. 

 

 

Figure 47. Manually selecting make and model 
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Note: This process is used to manually assign new devices only, not Redeployed 

devices. To manually assign Redeployed devices, please see Section 7.17 below. 

  

7.17  Manually Mapping Redeployed Assets 
 

It is also possible to manually map a redeployed asset to a virtual device.  To accomplish 

this hold down the SHIFT key when initiating a drag operation from a redeployed asset.  

The mouse cursor will change to indicate an asset mapping operation has been started. 

 

 

Figure 48. Initiating a manual asset transfer operation 

 

If the shift key is not held down the cursor will show a standard paper icon, indicating a 

volume transfer has been initiated and not an asset transfer.   

 

The asset can be dropped onto any virtual device provided the device is of the same type 

(e.g. printer or MFD).  When the asset has been dropped a blue line will be drawn that 

will show the mapping between the redeployed device and the virtual asset.  The virtual 

asset will change to show a white star instead of a gold star.  It will also take on the 

attributes of the redeployed asset (for example Colour and A3 capability). 

 

Figure 49. A manually mapped asset 

 

When a manual asset transfer 

operation has been initiated, the 

cursor will change to show an image 

of the asset being transferred 

Blue line 

shows 

redeployed 

asset to 

virtual asset 

mappings 

that have 

been done 

manually 

Star on virtual device changes 

to black and white to indicate 

the virtual device is under user 

control 



 Architect User Manual 

 - 38 - Asset DB v4.8.1 

 

An asset that is under user control is ignored by the Solution Generator function.  When 

the function is executed it will leave the details of any user controlled assets alone and 

will not remap any redeployed assets that have been manually mapped by the user. 

 

A manual mapping can be removed at any time by right clicking with the mouse on the 

virtual device and selecting the ‘Return to Solution Generator’ option. 

 

 

Figure 50. Returning a virtual device to the Solution Generator function 

 

The virtual asset will now be back under the control of the Solution Generator function 

and the white star on it will change back to gold to indicate this. 

 

Note that it is only possible to map a redeployed asset to one virtual asset.  If a 

redeployed asset is manually mapped to a virtual asset (indicated by the blue line), it will 

not be possible to initiate another asset transfer operation from it.   

It is also worth noting that a redeployed asset that has been manually mapped by the 

user cannot have its fate altered in the Device Fate view until it has been returned to the 

Solution Generator function.  
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Figure 51. Fate for manually mapped assets 

 

7.18  Using Filters 
 

In addition to the base Asset DB filters (explained in the Asset DB Analyst manual) 

Architect provides a filtering capability that lets you display only particular devices relative 

to their solution status. The filters specific to Architect are located in the ‘Solution’ tab 

within the Filter tab in the bottom left panel. 

 

 

Figure 52. The Solution Architect filter tab 

 

The tick boxes control the visibility of assets represented by the description as explained 

below: 

 

▪ Existing redeployed assets: If unticked all redeployed assets will be hidden.  If 

ticked, the assets shown depend on the drop down selection: 

o All Assets – all redeployed assets will be shown. 

o Assets with zero volume only – redeployed assets that have no volume 

on them will be shown. 

Fate is only red for redeployed 

assets that have been 

manually mapped by the user 
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o Assets with outstanding volume only – redeployed assets that have some 

volume yet to be transferred will be shown.   

▪ Existing disposed assets: Tickbox and drop downs as per existing redeployed 

assets above. 

▪ Virtual Assets: If unticked all virtual assets will be hidden.  If ticked, the assets 

shown will depend on the drop down selection: 

o All Assets – all virtual assets will be shown. 

o Manual changes only – virtual assets that are under the control of the 

user will be shown. 

o Solution generator controlled only – virtual assets that are under the 

control of the solution generator will be shown. 

▪ Existing assets marked ignore: If unticked all assets marked ‘ignore’ will be 

hidden.  If ticked all assets marked ‘ignore’ will be shown. 

▪ Show Volume Bin: Turns on and off the visibility of the Volume Bin. 

▪ Asset Status Labels: As described in Section 7.14. 

▪ Volume Transfer Links: Turns on and off the visibility of the volume transfer 

links as described in Section 7.1. 

 

If a filter is in use, the title of the filters tab is shown in red to indicate it is active. 

 

7.19  The Statistics Tab 
 

The normal Asset DB statistics tab has been enhanced in the Solution Design view to 

show both existing and virtual asset totals.   

 

 

Figure 53. The statistics tab in the Solution Design view 
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7.20  The Financials Tab 
 

If a TCO calculation has been created for the current state and results applied to the 

current state assets (details of this are in the Asset DB Analyst Manual) and Product 

Costs for the models making up the new fleet have been assigned (see Section 6.1) then 

the Financials tab will show a comparison between the current and Future costs. An 

incomplete solution will show a warning sign and the Future State costs are displayed as 

0 until the solution is complete. 

 

Figure 54. The Financials tab: incomplete solution for a selected floor 

 

Once a solution has been run the costs for Current and Future State appear next to each 

other. It is possible to select an individual site, building or floor to review the costs for this 

floor only, or to select the entire project as shown in Figure 55. 

 

Figure 55. The Financials tab: complete solution for a project. 

 

7.21  The User/Device Ratio Tab 
 

The User/Device ratio tab allows you to set a target User/Device ratio and monitor 

whether or not this is met.  

 



 Architect User Manual 

 - 42 - Asset DB v4.8.1 

 

To set the target ratio either use the up and down arrows or manually type the value 

corresponding to the MFD or Printer target. 

 

Next to these figures will appear a red cross if the target has not yet been reached (i.e. 

you have too many of this type of device on the floor) or a green tick if the target has 

been reached for the selected object (Floor/Building etc.). 

 

The actual current and future ratios for the selected object are also shown. This function 

relies on data entered into the “Staff Numbers” fields at Floor and/or Building level. 

Dropping “Person” or “Person Group” icons on the floor plan does not affect the “Staff 

Numbers” field, which is used for the user to device ratio calculations. 

 

 

Figure 56. The User/Device Ratio tab 

 

8 The Future State Tab 
The Future State tab is the final view in Solution Architect and is used to show the new 

print fleet that was designed in the Solution Design view.   

 

If your solution generator did not create a complete solution for a particular floor, you will 

get a warning of this as soon as you open the Future State tab for that floor. This will then 

give you the opportunity to return to the Solution Design tab and amend your solution to 

ensure it is complete. 
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8.1 Viewing a Summary of the Changes  
 

A pictorial summary of the changes for the floor can be viewed by using the Show/Hide 

Changes button on the toolbar. 

 

 

Figure 57. The Show/Hide Changes button 

 

There are several different types of changes that can occur as a result of the design 

process and these are all represented as follows: 

 

▪ Assets marked with an ‘X’: These are assets from the old fleet that were 

disposed. 

▪ Assets marked with a blue line: These are assets from the old fleet that have 

been redeployed and have been moved on the floor.  The start of the blue line 

indicates the origin of the asset (i.e. where it is currently) and shows where it has 

been moved to as a result of the redesign (the asset icon itself). 

▪ Assets marked with a ‘?’: These are assets from the old fleet that have been 

redeployed but they could not be mapped to any of the virtual devices created in 

the new fleet.   

▪ Assets marked with a red triangle: These are assets from the old fleet that 

have been redeployed and are moving off the floor to a different floor, possibly in 

another site or building.  To see where each asset is going place the mouse 

cursor over the asset and the destination floor and location of the asset will be 

shown.   

▪ Assets marked with a green triangle: These are assets from the old fleet that 

have been redeployed and are moving onto the floor from a different floor.  As 

above, to see where each asset has come from place the mouse cursor over the 

asset. 

▪ Assets with no markings and a gold star: These are new assets that do not 

yet exist.   

▪ Assets with no markings: These are devices which were marked as In Situ 

 

Show/Hide 

Changes 
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Figure 58. The change summary view 

 

9 Creating a Future State Green Analysis 
Just like for the current state, it is possible to create a Green Analysis for the future state 

assets. 

 

To start a Green Analysis for your future state, click File > New > Green Analysis (Future 

State). This will then produce the Green Analysis (Future State) tab. 

 

The basic process to run a Green Analysis on the Future State is the same for the 

process when running a Green analysis for the Current State. This is explained in the 

Asset DB Analyst Manual so will not be explained further in this manual. 
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9.1 Future State Assumption Sets 
 

One main difference between the Green Calculation for the Future State and the Current 

State occurs in the Assumption Set. An additional option to add a duplex percentage is 

added as shown in Figure 59. 

 

Figure 59. Future State Green Analysis assumption set 

 

This allows you to assign a heightened duplex percentage should your design imply that 

this will occur. 
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10  Generating Solution Reports 
 

Solution Architect has a report generation facility that can produce reports summarising 

the changes resulting from a fleet redesign.  Select Reports > Run.  

 

There are then three types of System solution reports that can be generated. 

 

10.1  Moves and Changes Report 
 

This is a complete summary of the changes to the existing print environment that result 

from the redesign.  The output is generated in either PDF or Word format and includes 

floor plan images in addition to textual information.  The textual information consists of a 

table organised by Site/Building/Floor that shows the fate of each asset in the existing 

fleet and lists any new assets that must be purchased as a result of the redesign.   

 

For each floor, the following images are generated (if relevant): 

 

▪ Floor plan with assets from the existing fleet that are to be disposed of. 

▪ Floor plan with assets from the existing fleet that are to be redeployed.  Any 

movement of the assets around the floor or onto/off the floor that is necessitated 

by the redesign is also shown. 

▪ Floor plan showing the new devices that need to be purchased for the floor. 

▪ Floor plan showing a change summary.  This summarises all the changes in the 

previous three floor plans onto one page. 

 

10.2  Device Fate Report 
 

This report lists all devices from the existing fleet and all new devices that must be 

purchased as a result of the redesign.  The output format is Microsoft Excel (.xlsm 

format).  Devices are organised into a Disposed, Redeployed, In Situ and New Devices 

section, each on a separate worksheet.  For each device all attributes are shown. 

Customised fields from the Current State, information will be displayed if the box “use in 

Solution Design” is ticked in the icon customisations. For more details, please refer to 

section 18.2 in the Auditor Manual. 

 

10.3  Future State Proposal 
 

Asset DB can also create a Future State Proposal Report showing details of the 

proposed future state which can be used to present to your customer. 
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The contents of this report mirror the Print Assessment Summary report, which 

summarises the current state. More can be found on the Print Assessment Summary 

report in the Asset DB Auditor Manual. 

The report can be generated by going to Reports > Run in the top menu. You can then 

select the Future State Proposal from the list and select Run. Note that to generate a 

report Asset DB requires a complete solution and for a logo to be available. 

 

The report can then be saved in various different formats including Word, PDF and 

PowerPoint using the options in the Save window. The report contains charts generated 

from the data in the Asset DB solution. Floor plans are also included based on what has 

been set up in the Future State Asset DB screen (i.e. whatever display options you have 

set up in Asset DB is what will show on the plans in the report). 

 

10.4  Editing Solution Reports 
 

It is also possible to edit the structure and style of the System Reports or to create new 

solution reports using the Asset DB Report Editor Tool. Please consult the Report Editor 

Manual for detailed instructions.  

 

For further information on the Report Editor Tool please contact info@newfieldit.com.  

 

11  Exporting and Importing Solutions 
Solution data can be exported from Architect in three ways; as a stand-alone Asset DB 

project containing only the “new” devices; as a current state project and solution “pair” or 

as a single Solution file. 

11.1  Exporting Solution to an Asset DB Project 
 

A solution can be exported to an Asset DB project.  This type of export will create a new 

Asset DB project that represents the redesigned fleet visible in the Future State view.  To 

export in this manner select Solution > Create Project from Future State from the menu 

bar. 

 

mailto:info@newfieldit.com
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Figure 60. The export to project button 

 

Note that the exported project is a normal Asset DB project and there is no solution 

related data present in the project.  If you open the project you will see it is almost 

indistinguishable from other projects.  Asset DB does maintain some very basic 

information about the origin of the project which is viewable by selecting the ‘Show 

Project Details’ menu option.  This displays a dialogue that shows the ID of the user who 

created the project, the time of creation and the solution from which the project was 

created. 

 

Top Tip: Creating a project from the Future State is critical to being able to show a 

Current State versus a Future State in CompleteView. Completeview can only reference 

Current State data, so to compare the Current to the Future, the Future State must be 

made into its own project. 

 

11.2  Exporting Solution Data as a Project and Solution pair 
 

Solution data can also be exported as a project and solution pair.  This type of export will 

keep all solution related data and allow a subsequent import of the data.  Both the 

underlying Asset DB project and the solution are exported.   

 

To export solutions in this format use the Export Project and Solution menu option. 
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Figure 61. Exporting solution data 

 

The exported data contains all information required to replicate the project and solution in 

another Asset DB Solution Architect instance. 

 

Top tip: if you have access to the Asset DB Cloud, it is better to synchronise the project 

with the Cloud and export the solution only (see section 11.3) as a means of backing up 

your data. This will ensure the solution remains linked to the most up-to-date version of 

your project. 

 

11.3  Exporting the Solution only 
 

The final method of exporting the Solution data is to export just the solution element of 

the project. 

To export solutions in this format, use the Export Solution menu option shown in Figure 

61. 

 

 

 

 

 

Export Solution 

component only 

Export Project 

and Solution 

together 



 Architect User Manual 

 - 50 - Asset DB v4.8.1 

 

11.4  Importing Solution Data 
 

Solution data that has been previously exported as a Project and Solution pair can be 

imported again by using the ‘Import Project and Solution’ menu option. 

 

 

Figure 62. Importing solution data 

 

The solution data is imported as a new Asset DB project and solution.  This is an 

important point to understand – even if you export solution data as a Project and Solution 

file (.ats) and then import it back into the same Asset DB instance it creates a new project 

and solution.  The new project will share a root name with the original project but will 

have ‘(Copy)’ appended to it. 

 

The solo Solution element can be imported back into its original project by using the 

‘Import Solution’ menu option. It is important to note that the Solution cannot be imported 

into a different project than the one in which it was created. 

It can, however, be imported to a synchronised version of the original project. 

 

Note: if you have access to the Asset DB Cloud then it is always advisable to share your 

projects via the Asset DB Cloud and your solutions using the File > Export > Solution 

mechanism. 

 

 

 

Import Solution 

into original 

project 

Import Project and 

Solution as new 

project 
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12  Invalid Changes 
In general, it is not advisable to make changes to the current state data once the Solution 

Design process has started. If changes are made Architect keeps track of these changes 

and automatically performs any necessary adjustments.  However there are 

circumstances in which an automated resolution is not possible and the solution will be 

invalidated without manual correction.  The most likely causes of invalid solutions are 

described in the following sub-sections. 

 

12.1  Adjusting Existing Fleet Volumes 
 

If volume data is adjusted after a design has been started the following caveats apply. 

 

Device volumes can be increased without any problems.  Note that if you increase the 

volume on a device you will need to revisit the Solution Design view to transfer the extra 

volume onto a virtual asset.  You will also need to rerun the Solution Generation function. 

Device volumes can be decreased provided the amount to which they are decreased is 

not less than the amount of volume that has been transferred from the asset in the 

Solution Design view.  For example, if the original volume on an asset is 500 and during 

the Solution Design process 200 has been transferred into the virtual print environment it 

is not advisable to adjust the volume of the asset to below 200.  Adjusting the volume to 

less than this figure will invalidate the solution and cause the asset to show a negative 

volume figure in the Solution Design view. 

 

12.2  Deleting Existing Assets 
 

Removing a device from the existing fleet after a solution design has been started is fine 

if the device has been marked for disposal and the volume from that device has not been 

transferred to a virtual device.  If a device marked for retention is removed the solution 

generation function will need to be run again because the device may have been 

distributed into the virtual environment and will need to be removed from it. 

 

 

12.3  Changing Make and Model Data 
 

If the Make or Model for a device is changed and the device has been marked for 

retention it is necessary to revisit the Product Catalogue and allocate the new Make & 

Model to a volume profile. 
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13  Frequently Asked Questions 
Architect can be a very fluid and helpful tool, below are some of the topics that support 

receives inquiries about on a regular basis. 

 

What is “In Situ”? I cannot add volume to “In Situ” devices? 

“In Situ” is Latin. It translates to “on location” or “in situation”. Architect uses that 

designator to show that a device will not be changing in any way in the transition 

including adding volume, so volume may not be added to an “In Situ” device. To be able 

to increase the volume, use the “Redeploy” device fate. 

 

How do I get a product catalogue? 

Xerox does not keep or maintain Product Catalogues to provide to users so you will need 

to create one (see Section 5.4). Device configuration offerings and costing information for 

each group, company and user make this unfeasible. While it may take some time to 

develop the catalogue the first time, it can be saved and even shared with teammates 

using the Solution > Export > Product Catalogue and Solution > Import > Product 

Catalogue functions. 

 

Why does the Current State cost for “Redeploy” and “In Situ” devices not carry 

into the Future State Product Costs tab? 

Asset DB assumes that any devices in the Future State are going to be managed 

differently than they were in the Current State. Very rarely does a proposal use the same 

monthly cost and/or cost per page as was originally determined, therefore the costs do 

not carry over, and cannot be “accidentally” left unticked in the new scenario. 


